Description

Simple Building Slab
Design

For LUSAS version: 17.0

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): | None.

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description
Four panels of a concrete slab Line Support
supported by a wall, columns and a T
lift shaft are to be analysed, with Panel A Panel B
reinforcement areas computed for
bending moment only. Shear and Slab Thickness 200mm 6m
displacement checks need to be | Soncrete o Nimn
carried out separately. The geometry Columns
of the slab is as shown. e
e
The slab is subjected to self-weight Panel ¢ Panel D
and a live load.
i i 2 < \ Line 6m
The units of the analysis are N, m, Supports

kg, s, C throughout.

Objective [} i Il (] -
|
\

U To produce areas of } 6m

reinforcement under ultimate
loads and check crack widths under service loads

Keywords

2D, Plate, Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel Area, Load
Combinations, Smart Combinations, SLS, ULS, Cracking
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Associated Files

U slab_design_modelling.vbs carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller in
the Introduction to LUSAS Worked Examples document..

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as Slab_Design

o Enter a file path for the working folder.

e Set the Analysis type to be Structural

e Set the Analysis Category to be 2D Grillage/Plate

e Select model units of N,m,kg,s,C

e Ensure the timescale units are Seconds

e Select the Startup template None from those available in the drop-down list.
o Enter the title as Slab Design Example

e Leave Layout grid set to None and click the OK button.

The Attributes &% treeview will be populated with potentially useful basic line mesh,
geometric and support entries appropriate to the settings made on the new model dialog.

Note. The Analysis category determines which elements will be available for
modelling. Here we are only interested in the out-of-plane bending effects in a flat slab
and therefore we can approximate this behaviour with 2D plate elements.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.




Modelling

Feature Geometry

G . .
| fs"u”;ZCZ > _I Enter coordinates of (0, 0), to define the lower
~ [By Coords... left-hand area of slab, and using the Tab key to move
to the next entry field enter coordinates of (6, 0), (6, 6)
and (0, 6). With all the coordinates entered click the
OK button to create a surface.
Fiiy
e  Select the newly created Surface.
|G§’$‘;Z S M Copy the selected surface with an X translation
“[copy...  of6. Click the OK button to create the new Surface.
e Use Ctrl + A keys together to select the whole
model.
|G|eS°$ZtCZ 3 M Copy the selected surfaces with a Y translation of
“[Copy... 6. Click the OK button to define two new Surfaces.
iy
Defining a Hole in a Slab ==
Next, a hole representing the lift shaft needs to be defined. This is done by first creating
a surface representing the extent of the lift shaft and then selecting both the surrounding
and inner surface to define the hole.
G .
| B > I8 £ter coordinates of 2, 2), (4, 2), (4, 4) and (2,
[By Coords... 4) and click OK to define the extent of the hole.
e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)
| Geometry e Ensure Delete geometry defining holes is
|Su:|fa|ce > selected A new singular Surface will be created. 4
oles >
ICeate  This new surface containing the hole can be seen / B

checked by clicking in a blank part of the Graphics Window and then re-selecting the
lower-left hand surface.




| File

Model Properties...

| Attributes

Mesh >
Surface...

| Attributes

Mesh >
Line...

| Attributes

Geometric >
Surface...

Simple Building Slab Design

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default lines normally have 4 mesh divisions per line. If you are using the Teaching
and Training version this default value should be left unaltered to create a surface
element mesh within the limit available. This will give a coarser mesh and
correspondingly less accurate results will be obtained. Otherwise, for this example, and
to give greater accuracy, 8 divisions per line will be used.

e Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

e Select the element type as Thick Plate, the element shape as Triangle and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions
to be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

e With the whole model selected drag and drop

the mesh attribute Thick Plate from the &
Treeview onto the selected Surfaces [

In the vicinity of the lift core less elements are
required.

e Select the element type as None and enter the
Number of divisions as 4. Enter the attribute
name as Divisions=4 and the OK button

e Select the 4 lines defining the lift core and drag B

and drop the line mesh attribute Divisions=4 from the & Treeview onto the
selected Lines.

In this manner the mesh density on slabs can be varied according to the levels of detail
required.

Geometric Properties

e Enter a thickness of 0.2. Enter the attribute name as Thickness 200mm and click
the OK button.
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| Material

| Material Library...

| Attributes

>

| Support...

e With the whole model selected drag and drop the geometric attribute Thickness
200mm from the € Treeview onto the selected Surfaces.

Geometric properties are visualised by default.

e Inthe X" Treeview drag and re-order the layers so that the Attributes layer is at the
top of the Treeview, followed by the Mesh layer, followed by the Geometry layer.
Delete the Utilities and Deformed mesh layers if present by right clicking and
selecting Delete.

ll Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

e Select material type Concrete, region Europe, standard EN1992-1-1:2014 and
grade C40/50 and click OK to add the material attribute to the & Treeview.

e Select the whole model and drag and drop the material attribute Isol (C40/50
Concrete EN1992-1-1:2014) from the &b Treeview onto the selected Surfaces.

Supports
e Select Fixed for Translation in Z and enter the
attribute name Fixed in Z and click OK. ?E:Efst mse

. . assign Fixed in Z
For clarity the mesh layer is not shown on these

diagrams, // % %

e Select the 6 points where the columns are located.

e Assign the supports by dragging and dropping the
support attribute Fixed in Z from the & ﬁi s
Treeview and assign to All analysis loadcases by i
clicking the OK button.
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e Select the 2 Lines representing the line support

and drag and drop the support attribute Fixed in H
Z from the &% Treeview and assign to All Select these 2
analysis loadcases by clicking the OK button. t:;‘:j ’;‘:‘imgn

e Select only the top, bottom, and left-hand lines
defining the lift shaft and drag and drop the . Select these 3
support attribute Fixed in Z from the & %} Linesand assign
Treeview and assign to All analysis loadcases ' Fixedinz
by clicking the OK button.

El Select the isometric view
button to check that all supports
have been assigned correctly.

< NAA Click this part of the

status bar to view the model from
the Z direction again.

Loading
| Attributes e Select Body Force and click Next.
Loading...
e Enter an acceleration of -9.81 in the Z direction.
e Enter an attribute name of Self Weight and click the Finish button.
| Attributes e Select the Global Distributed radio button and click Next.
Loading...

e Select the Per unit area option.
e Enter -5000 in the Z Direction.

e Enter the attribute name as Imposed Load 5kN/m2 and click the Finish button.




Modelling

Now the dead and live loading needs to be %
assigned to each slab panel of the building. This
is done using separate load cases so that the
loadcases can be combined to determine the
most adverse effects.

In the Analyses () Treeview, right click on - AN ¥

Analysis 1 > Loadcase 1, select the
Rename option and change the loadcase
name to Panel A Permanent

Select the surface representing the top left-
hand panel (Panel A). =2

Assign the dead loading by dragging and dropping the attribute Self Weight from
the &b Treeview onto the selection. The loading assignment dialog will be
displayed. Select the Single Loadcase option, the analysis Analysis 1 and loadcase
Panel A Permanent, then click the OK button.

Note. The loading assigned to each panel will be visualised for each loadcase as it is
assigned to the model

Drag and drop the dataset Imposed Load 5kN/m2 from the &% Treeview onto the
selection, accepting all defaults, and change the loadcase name to Panel A
Variable and click the OK button.

Select the top right-hand panel (Panel B).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection, accepting all defaults, and change the loadcase
name to Panel B Permanent Leave the load factor as 1 and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection and change the loadcase name to Panel B Variable and click the OK
button.

Select the bottom-left panel (Panel C).

Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection. Change the loadcase name to Panel C
Permanent and click the OK button.

Drag and drop the attribute Imposed Load 5kN/m2 from the & Treeview onto the
selection. Change the loadcase name to Panel C Variable and click the OK
button.

Select the bottom right-hand panel (Panel D).

7



| File

Save
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e Assign the dead loading by dragging and dropping the attribute Self Weight from

the &b Treeview onto the selection. Change the loadcase name to Panel D
Permanent and click the OK button.

e Drag and drop the attribute Imposed Load
5kN/m2 from the & Treeview onto the
selection. Change the loadcase name to ]
Panel D Variable and click the OK
button.

The 2 Treeview should now contain eight !
loadcases consisting of a Permanent and
Variable loadcase for each panel.

Saving the model 4

El Save the model file.

Running the Analysis

&

With the model loaded:

;l Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. LUSAS Solver uses this
datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the () Treeview.
Addition files will be created in the directory where the model file resides, including:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.

U slab_design.mys this is the LUSAS results file which is loaded automatically
into the ™= Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.




| File
New...
| File
Script >
Run Script...

Viewing the Results

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully.

O slab_design_modelling.vbs carries out the modelling of the example.

Ql Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

o Enter the file name as Slab_Design
e To recreate the model, select the file slab_design_modelling.vbs located in the

\<LUSAS Installation Folder>\Examples\Modeller directory.

=
;l Rerun the analysis to generate the results.

Viewing the Results

Analysis loadcase results are present in the () Treeview and load case results for the
last solved loadcase are set to be active by default.

e Turn off the Attributes layer
in the = Treeview.

e Inthe (5 Treeview right-click
on results loadcase Panel A
Permanent and choose Set
active

Maximum 1 7 901 TES at node 708
Minimum -8 §5149E3 at node 17

e With no features selected,
click the right-hand mouse
button in a blank part of the
active window and select the L

Contours option to add the contours layer to the & Treeview.

.

e  Select entity Force/Moment - Thick Plate and results component MX to see the
results for Permanent effects in Panel A.

Wood-Armer Results

Slab design will be carried out based on the Wood-Armer moments in the slab. These
results are computed from the orientation of the reinforcement, so the reinforcement

9



| Attributes

Design >
RC Slab Design...
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capacities/details must be defined and assigned to the model before results can be made
available. Two attributes are available from which Wood-Armer moments can be
calculated, and these are accessed from the Attributes > Wood Armer and Attributes >
Design > RC Slab Design menu items. Since we are going to carry out slab design
calculations we will create an RC Slab Design attribute.

Defining RC Slab design attribute

[ ] From the Slab Design Attribute =
1 - Analysis g . .
Reinforcement Library ..o =
select bar sizes as | s [ - AT o
Metric. : details P P [, (I ‘I

~Top Face LA A
i Basinx [layer1 v] [lZom x| [1500  mm ;7 ‘(/ L
e Set all bar sizes as basiny [BEE " [ ][R0 e Z; , T?Dlayerz
12mm and leave the | eommrece ] i
Barsinx [Layert =] [ =] [500 | mm 1 :
i o ;
o

spacing as 150mm. Barsiny [Layer2 [izom =] [1500 | mm

cover |

o Set the tOp and bottom e Top [200 Botom [200 | mm ?nari A Bottom layer 2
cover to be 20mm. I Use nominal cover in crack width calculations , / .
Nominal cover  Top [200 | Botom [0 mm . Pt

e  Ensure the angle of bars (””“"““’" o . ‘
R . i ) Angle of bars in y' from bars inx 90.0
in y* from bars in x is
(o]
set to be 90 e (5 BT
e Enter the attribute name [CGme ||| Coooel [ fooy || Hew

as Slab and click OK.

Assigning RC slab design attribute

e  Select the whole model and drag and drop the RC Slab attribute Slab (T[C=20mm,
DiaX=12mm, DiaY=12mm], B[C=20mm, DiaX=12mm, DiaY=12mm],
Skew=90) from the & Treeview onto the selected Surfaces.

Note. Assigning the RC Slab attribute adds a new results entity Wood Armer — Thick
Plate to the available results.

10



| Analyses
Smart
Combination...

Viewing the Results

e In the Treeview
right-click on
Contours and choose
Properties

aximum 0.0 at node 18

e Set the Entity as nmm s
Wood Armer — Thick
Plate and Component
as MX(B), click OK to
close the dialog and
plot the contours

Defining Load Combinations

The loadcases will be combined to provide the most adverse loading effects. This is
achieved using the smart load combination facility within LUSAS Modeller. For
Ultimate Limit State (ULS) design to EN1990:2002 requires permanent actions to be
factored by 1.35 where unfavourable and 1.0 where favourable. Unfavourable variable
actions are factored by 1.5 and omitted where favourable. (These factors may be subject
to national variation)

U For permanent actions this is equivalent to a Permanent load factor of 1.0
and a Variable load factor of 0.35 since 1.0 will always be applied and 0.35
will only be applied if it creates an unfavourable effect.

O For variable actions this is equivalent to a Permanent load factor of 0.0 and a
Variable load factor of 1.5 since the loading will only be applied if it creates
an unfavourable effect.

Note. Permanent load factor and Variable load factor refer to the LUSAS Smart
Combination definitions rather than the EN1990 definitions.
ULS design

e Include all loadcases in the smart combination. To do this select the first load case
in the loadcase selector at the bottom-left of the then hold the Shift key down and
scroll down the list and select the last loadcase.

e Click the LI button to add these loadcases to the included list.

e In the grid set the permanent and variable factors as shown in bold text in the table
that follows:

11
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Name Permanent Factor Variable Factor
Panel A Permanent 1.0 0.35
Panel A Variable 0 1.5
Panel B Permanent 1.0 0.35
Panel B Variable 0 1.5
Panel C Permanent 1.0 0.35
Panel C Variable 0 1.5
Panel D Permanent 1.0 0.35
Panel D Variable 0 1.5

e Change the smart combination name to ULS
e Click the OK button to complete the definition of the smart combination.

A maximum and a minimum smart combination entry will be created in the G
Treeview. The maximum combination will produce the most adverse hogging moments
whilst the minimum combination will produce the most adverse sagging moments.

Note. When the properties of the max combination are modified the corresponding
min combination is updated automatically.
SLS design

For SLS Design, calculation of crack widths will be based on service loads and hence a
second combination is required.

e Include all the results loadcases (but not the two ULS combinations) in the Smart
combination. To do this select the first load case in the loadcase selector at the
bottom-left of the then hold the Shift key down and scroll down the list and select
the last loadcase.

e Click the LI button to add these loadcases to the included list.

e Enter the load factors in the grid as follows

12



Viewing the Results

Name Permanent Variable
Factor Factor
Panel A Permanent 1.0 0
Panel A Variable 0 1.0
Panel B Permanent 1.0 0
Panel B Variable 0 1.0
Panel C Permanent 1.0 0
Panel C Variable 0 1.0
Panel D Permanent 1.0 0
Panel D Variable 0 1.0

e  Change the smart combination name to SLS
e Click the OK button to complete the definition of the smart combination

° Select ULS (Mln) Combining on: MX
ULS (Min)
Entity: Wood Armer - Thick Flate

from the @ Treeview Component: MX(B) (Units: N.m/m)
with the right-hand l 74 1181Es
mouse  button and

-57 B4T4E3
-494121E3

. . --41.1787E3
pick the Set Active -320414E3
option. i o755

Maximum 0.0 at node 16
Minimum -74.1181E3 at node 45

e In the Set Active
dialog ensure Max/

min primary
component with
coincident effects is
selected.

e Select entity Force/Moment — Thick Plate and results component MX to
combine, applying the variable factors based on the minimum moments in the X
direction and click the OK button.

Caution. Using smart combinations with “derived components” may not provide the
expected results. The online help provides details of such circumstances which you
should fully understand before using this facility. In this worked example a linear
primary component is being used to create the smart combination from which the

13
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Wood-Armer values will be computed. It will be necessary to carry out design checks
using primary components in both directions (X and Y) to ensure the most onerous
combination is found.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and covers provided in the RC Slab
attribute.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.

RC Slab Design: Design Code Settings

e Ensure that United Kingdom
and BS E N 1992_1_ _DBSng:u::ie [Unted Kingdom |
1:2004/NA:2005 are selected Dsimesde  [s5en ser 2o N
from the dropdown list of T
countries and design codes S = =
SLS crack checking  [Bzndr 2l
e Change the Characteristic yield Desionpramtes
strength of the reinforcement to A —— e wes
Material factor for reinforcing stee! (ys) [5
460 and ensure the Modulus of elasticity of reinforcing steel (Es) [0 GPe
Toti H Characteristic cylinder strength of concrete (fck) [0s | wPs
Characterlst_lc cylinder strength e —— —
Of concrete is 40 Coeffcient for long term and unfavorable effects (cc) I
e Click Next to proceed to the betata Bk || Wea» | Fmh ] | cowesl | Hob
_ois| | |

Crack Width Settings page.

Note. For 2D plate models the design calculations options are set to bending only. For
a 3D model comprising shell elements, slab design can be carried out considering in-
plane effects as well as bending.

14



Viewing the Results

RC Slab Design: Crack Width Settings

e Ensure the crack width settings

[~ Calculation properties [~ Elastic moduli

are as shown on the adjacent 5 Usocode efnedvles
. Allowable crack with (mm) | E— Creep coeficient (Phi) 2
dialog. e |

£ User defined values

° Click the Finish button to ’7(“”““"" @l @l Shortterm modulus of concrete GPa [350
Close the dlalog Long term modulus of concrete GPa [0

[~ Effective elastic modulus for concrete.

¥ Quasi-permanent

" Interpolated. based on proportion [ Creck width parameters

Two new results entities Slab Vot et To e () [0 || | Cosemtlonddntint) o4

. . ermanent effects: Total effects (%) [20.0 EriEE m T s ) oz
Design (ULS) and Slab Design B Coctirtorsain tn ) [05——

4 Interpolzted, based on calculated proportion

(SI_S) will now be available for e e e ST S o)

. . . I = @ B2 wpr | @
selection in all results processing ] T
facilities.

based on the
led {permanent)

Defaults < Back ext Finish | Cancel | Help

Viewing results for bottom face of slab

With loadcase ULS (Min) still _
e in the (B Troeview. | EHAOT
set active in the Treeview: Entity: RC Slab (ULS) - BS EN 1992-1-1:2004/NA:2005

Component: UtilMax(B)

] ) 0.0
e Inthe Treeview double- . 0168470

click on the Contours layer 0.508426
and select entity RC Slab T oieas
(ULS) — BS EN 1092-1- g i4s
1:2004/NA2005 and  Vinmum 0.0 st neae 17 "

component UtilMax(B).

It can be seen that the utilisation is exceeded by approximately 51%.

Note. UtilMax(B) provides the maximum of two utilisations Util(Mx(B)) and
Util(My(B)). The first is based on the Wood Armer component MX(B) and the slab
bending capacity in the that direction. The second is based on MY(B) and the
corresponding capacity in that direction. Individual utilisations may be viewed with
respective components Util(Mx(B)) and Util(My(B)).

Plotting contours of bottom reinforcement area

e In the Treeview double-click on the Contours layer and change the contour
results component to Asx(B) to determine the area of steel required in the bottom
layer x direction. A steel area of 1135mm2/m is required, which can be
accommodated by using 16mm bars at 150mm centres.

15
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Changing bottom reinforcement bar sizes

A check is also required that the
same face is adequate when the

In the €% Treeview double click the RC Slab attribute Slab and change the bottom
bar diameters used in the bottom face to be 16mm in both the x and y* directions.
The slab design will be recomputed.

In the Treeview double-  combining on: mx

ULS (Min)

click on the Contours Iayer Entity: RC Slab (ULS) - BS EN 1992-1-1. 2004/NA: 2005

Component: UtilMax(B)

and select results component .(,_0
UtilMax(B). A  maximum 0204228

0.306337

utilisation of around 0.92 can D.s0sds

be seen, so the bottom E:E}EEQ?
reinforcement is now @m 0919012 a1 nod 50
adequate_ inimum at node

smart combination is optimised for MY

Select ULS (Min) from the .@ Treeview with the right-hand mouse button and
pick the Set Active option.

In the Set Active dialog set the primary component to be MY and check that this
combination is also satisfied. A maximum utilisation of just under 0.95 is seen.

Viewing results for top face of slab

The viewing results process described previously needs to be repeated for the top face
of the slab, using the combination that will generate the maximum effects in the top
face:

Select ULS (Max) from the () Treeview with the right-hand mouse button and
pick the Set Active option.

In the Set Active dialog select Max / min primary component with coincident
effects entity Force/Moment — Thick Plate and results component MX to
combine, applying the variable factors based on the moments in the X direction and
click the OK button.

In the = Treeview double-click on the Contours layer and select entity RC Slab
(ULS) — BS EN 1992-1-1:2004/NA:2005 and component UtilMax(T).

Here the utilisation is exceeded around the central support. To determine how
widespread the problem is the contour range will be modified:

16



Viewing the Results

e Double-click the contours

layer in the Treeview,
select the Contour Range
tab, check the maximum
option and enter 1.0, and
then click OK. The
adjacent image shows the
extent of the problem.

Combining on: MX

ULS (Max)

Entity: RC Slab (ULS) - BS EN 199
Component: UtilMax(T)

0.0

012
0.25
0.37
0.5

0.62
0.75
0.87

3

1.0
|
Maximum 4.01757 at node 708

Minimum 0.0 at node 22

Changing top reinforcement bar sizes

e Repeat the procedure of
changing the
reinforcement bar sizes
for the top layer from
12mm diameter to 16mm
diameter bars. The extent
of the failure is reduced
and now much more
localised around the
central support.

Combining on: MX

ULS (Max)

Entity: RC Slab (ULS) - BS EN 199
Component: UtiiMax(T)

0.0
0.27056
0.54112

0.811679
1.08224
1.3528
1.62336
1.893082
216448

Maximum 2.43504 at node 708
Minimum 0.0 at node 22

e Reuvisit the contours layer
properties and remove the maximum value for the contour range. Whilst the
utilisation is greater than 1, the area of which this value occurs is very localised.

Note. Whilst it is tempting to increase the size of the reinforcement further it is
important to understand the limitations of the idealised analysis model. Very high
moments are generated at the point support. In reality this support will have some width
which will reduce the support moments. It is possible that the model could be refined to
account for these support conditions, alternatively the designer should satisfy
him/herself, through hand calculation or otherwise, that the forces and moments in the
actual configuration (accounting for column sizes and drops etc) can be satisfied.

Caution. The ULS design of reinforcement assumes that the slab is “under-
reinforced” and therefore the calculations are only valid when this holds true. The
contour plots Util(tex(T)), Util(tcy(T)), Util(tex(B)) and Util(tcy(B))  provide
utilisations on Tension Control and indicate whether the slab will undergo ductile
failure and is hence “under-reinforced.” Plots of Tension Control must therefore be
checked to ensure a valid design. For more information see the online help.
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Concrete crack checking

The calculation of crack widths in the RC Slab Design facility is based on principal
moments rather than Wood-Armer moments as used in reinforcement design. Effective
steel areas are interpolated based on the orientation of the principal moments with
respect to the steel bar directions. Extensive coverage of the crack calculation
procedure is provided in the Application Manual (Bridge, Civil & Structural).

Crack width checking (bottom face)
e Select SLS (Min)

from  the Crbning on: MX
H H Entity: RC Slab (SLS) - BS EN 199§
TrEEV|EW Wlth the anl'lgonent: %W‘Maxt’BJ (Units: mm
right-hand  mouse . 0.0

button and pick the 0 0384553

Set Active option. 0 1ende.

. WL

e In the Set Active 0233683
dialog  set the Maximum 0.262904 at node 78

primary component ~'"mdm 2.0 atnode

to be MX

e Inthe &= Treeview
double-click on the Contours layer and select entity RC Slab (SLS) — BS EN
1992-1-1:2004/NA2005 and component CWMax(B). This displays the maximum
crack widths calculated in the bottom face.

Note. A warning message is displayed when the effective steel stress calculated
exceeds the nominal yield value. Only the maximum value is reported along with the
face at which that occurs but it is possible that the maximum value may be exceeded in
both faces. In this example the maximum steel stress reported arises from hogging over
the central support.

The crack widths in the bottom face are found to be within acceptable limits. The top
face now needs to be checked.
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Viewing the Results

Crack width checking (top face)

e Select SLS (Max) from

the (5 Treeview with  Smting o Mx
- Entity: RC Slab (SLS) - BS EN 199
the rlght-hand MOUSE  Component: CWMax(T) (Units: mm

button and pick the Set . 0.0

- . 0.0826786
Active option. 0.165357

0.248036
0330714
0.413383

e Inthe Set Active dialog 0.436072

set the primary g 0551429

component to be MX Mimmom 0.0 af node 23 0% 10

e In the Treeview
double-click on the
Contours layer and select entity RC Slab (SLS) — BS EN 1992-1-1:2004/NA2005

and component CWMax(T). This displays the maximum crack widths calculated
in the bottom face.

It can be seen that the over-utilised area is concentrated around the idealised support
condition and the designer must determine the validity of this assessment.

Note. The crack checking calculations are based on strains calculated from an
interpolated effective area of steel. However the actual crack width is calculated taking
the bar spacing and bar diameter of the layer orientated closest to the principal moment
in question. Contour plots for crack widths “controlled” by each reinforcement layer are
provided to identify exactly which bars are controlling the cracks. By default the
maximum crack width is displayed.

Note. Slab design results will be available as a results entity until they are turned off

by selecting “None” on the slab design dialog.

Save the model

El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.
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Discussion

Simple Building Slab Design

Element types and orientation of results

The orientation of the slab reinforcement is aligned with the results axes. In this
example thick plate elements are used whose results axes are always transformed to the
global directions.

If shell elements are used (when appropriate) the results must be transformed into a
consistent direction coinciding with the intended direction of the reinforcement. By
default shell results are orientated along the local element axes.

The following result contours shows the indicative difference between results from
global (left) and local (right) axes for a ULS(Max) MX(B) plot.

Global Axes Local Axes

e The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transform Set... button on a results
layer’s Properties dialog. Selecting Global axes will transform local element results
into the global axes system. Other options are available..

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase X, y and z (when seen) are used to denote local results or
transformed results.
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horizontal 2D slice section through the central three columns typically varies with the

default mesh density of 4 divisions per line a slightly reduced accuracy of results will
number of line mesh divisions used.

have been obtained.
The following graph for ULS(Min) shows how Bending Moment (MX) along a

If the Evaluation Version of LUSAS was used to carry out this example with a reduced

Element density and results obtained
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In general, more accurate results are obtained when using more line mesh divisions and

hence more elements when modelling slabs of this type. Care should always be taken to
use an appropriate number of elements together with a possible refinement of the mesh

in areas of interest in order to obtain the best results.
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